Wetlands Regulatory Assistance Program ERDC TN-WRAP-04-2
September 2004

Availability of a PowerPoint-Based
Tutorial on Applying PLOAD
for Wetlands Management

by Jeff P. Lin and Barbara A. Kleiss

PURPOSE: This technical note announces the availability of an Engineer Research and
Development Center (ERDC) PowerPoint tutorial titled “Using PLOAD to Estimate Pollutant
Loading into Wetlands.” This tutorial, used in conjunction with the existing PLOAD user’s manual
(http://www.epa.gov/ost/BASINS/b3docs/PLOAD v3.pdf), is aimed at instructing wetland planners
and regulators in using the PLOAD software as a wetlands management and analysis tool.

BACKGROUND: PLOAD is public domain software created by CH2M HILL, and was designed
to estimate point and non-point pollutant loading into watersheds. It is an extension of the U.S.
Environmental Protection Agency’s (EPA’s) BASINS watershed and water quality assessment
software. Although PLOAD runs within ArcView® 3.x GIS, the end user need not have a working
knowledge of the ArcView® software in order to utilize PLOAD.

Although PLOAD was designed for use at a watershed or subwatershed level, it can also be used at a
much smaller scale and applied to individual wetlands. Using PLOAD, pollutant loads into wetlands
of any size with a defined catchment can be estimated. Also, changes in pollutant loads into a
wetland can be estimated for any project affecting land use changes or the incorporation of BMPs in
the wetland’s catchment.

DESCRIPTION OF THE TUTORIAL: The tutorial is broken into several sections, covering the
following topics:

e Description and availability of the PLOAD software.

e Using PLOAD for wetlands management.

e PLOAD data requirements.

e Obtaining necessary data.

e Identifying applicable wetlands.

e Using the “Simple” and “Export Coefficient” calculation methods.

e Incorporating and analyzing the effects of BMPs on pollutant loading.

e Incorporating and analyzing the effects of land use changes on pollutant loading.

For those unfamiliar with using ArcView® 3.x, the main tutorial also contains several optional
sections on pre-processing shapefiles for input into PLOAD.

The tutorial focuses on applying PLOAD to wetlands. The tutorial is not meant as a replacement for
the PLOAD user's manual, as it does not cover in detail the basics of operating the PLOAD software.
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POINTS OF CONTACT: The tutorial is available online at Attp.//el.erdc.
usace.army.mil/wrap/tools.html. This technical note was written by Mr. Jeff P. Lin and Dr. Barbara
A. Kleiss, at the Engineer Research and Development Center, Vicksburg, MS. For additional
information, contact Mr. Lin (601-634-2068, Jeff.P.Lin@erdc.usace.army.mil) or the Manager of the
Wetlands  Regulatory  Assistance  Program,  Mr. Robert  Lazor  (601-634-2935,
Bob.L.Lazor@erdc.usace.army.mil). This technical note should be cited as follows:

Lin, J. P. and Kleiss, B. A. (2004). “Availability of a PowerPoint-based tutorial on applying
PLOAD for wetlands management,” WRAP Technical Notes Collection (ERDC TN-WRAP-
04-2), U.S. Army Engineer Research and Development Center, Vicksburg, MS.
www.wes.army.mil/el/wrap

NOTE: The contents of this technical note are not to be used for advertising, publication, or promotional purposes.
Citation of trade names does not constitute an official endorsement or approval of the use of such products.


http://el.erdc.usace.army.mil/wrap/tools.html
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The purpose of this tutorial is to introduce the user to the PLOAD software, and
demonstrate how to apply it in measuring pollutant loads into wetlands. The
tutorial is meant as a supplement, not a replacement, for the existing PLOAD
user's manual, and as such, does not cover basic operation of PLOAD software.

There are several reasons that measuring pollutant loading into wetlands might
be of interest and concern to those involved with wetland management and
regulation.

For example, urban development around a wetland is likely to increase pollutant
loads into that wetland. Because heavy pollutant loads may adversely affect
wetland functions, estimating the increase in pollutant load due to the
development may be of interest for regulatory purposes.

Also, many wetlands can improve water quality by removing pollutants from
runoff before they reach a receiving water body. Measuring the potential
pollutant load into a wetland can be useful for management purposes by helping
planners decide where to create or restore wetlands so that they will provide the
most water quality benefit.
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Tutorial Introduction

PLOAD requires ArcView® 3 x GIS software to run. Operational
knowledge of ArcView® 3.x is not necessary in order to run
PLOAD. However, some of the geographic coverages used in
PLOAD may need to be pre-processed in ArcView before being
input to the program. This tutorial contains optional sections on
performing some of this processing, for those unfamiliar with using
ArcView®. The files used in these sections can be downloaded at
http://el.erdc.usace.army.mil/iwrapftools.html

Many slides will have the D icon in the upper right corner.
Clicking on this icon brings users back to the ‘Tutorial Sections'’
page. The tutorial also contains many hyperlinks that take users to
other sections of the tutorial. Hyperlinks appear as underlined blue
font words, like this.

Questions or comments on the tutorial can be addressed to:
Jeff P Lin@erdc.usace.army.mil

yrial Sections

Section 1: Introduction to PLOAD

Section 2: PLOAD Data Requirements
Section 3: Identifying Applicable Wetlands
Section 4: Running PLOAD

Section §: Choosing a Calculation Method
Section 6: Incorporating BMPs

Section 7: Incorporating Land Use Changes
Section 8: Sources for Obtaining Data
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Section 1: Introduction to
PLOAD

Section 1: Introduction to PLOAD

Calculates pollutant loads for watersheds/basins.
A simple, screening-level GIS-based model.

PLOAD is an extension of EPA’s BASINS water
quality software, available at this website:

http://www.epa.gov/docs/ostwater/BASINS/

PLOAD and BASINS are free, public domain
software.
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Section 1: Introduction to PLOAD

What can PLOAD be used for?

« Estimating pollutant loads into a wetland from
point and non-point sources.

« Estimating changes in pollutant load after
incorporation of BMPs.

 Estimating changes in pollutant load due to
changes in land use.

« Generating map outputs of pollutant loads by
basin.

Map Output

PLOAD Map Outputs:

1. Total pollutant load (Ibs) by basin
2. Pollutant load by basin area (lbs/acre/yr)

3. EMC by pollutant (for “simple” calculation method)
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Section 2: PLOAD Data
Requirements
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Section 2: PLOAD Data Requirements

PLOAD calculates pollutant loads using one of two
methods:

The “Simple” Calculation Method
(Detailed in Section 4)
The “Export Coefficient” Method
(Detailed in Section 5)

Different data sets input by the user are needed for
each of these methods.
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Required for Both Calculation Methods

. Watershed/Basin boundaries

. Watershed/Basin land use coverage
Required for “Simple” Calculation Method
. Annual precipitation data for the area

. Event Mean Concentration (EMC) table for pollutant(s) of
interest

. Land use imperviousness table
Required for “Export Coefficient” Calculation Method

. Export Coefficient table

Optional Data for Both Calculation Methods
. BMP efficiency table

. Point source pollutant data table

Section 2: PLOAD Data Requirements >

Land Use Coverage
PLOAD requires that the user input a land use ArcView shapefile. The
landuse file must cover the entire area of the basin(s) being examined. The
land use coverage should also have a corresponding database (.dbf) file,
which must contain the following columns:

1. A palygon ID column 2. A land use ID column

ibutes of 1199_lu_class.sl
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Section 2: PLOAD Data Requirements ({umm

Land Use Coverage Example B

Section 2: PLOAD Data Requirements

EMC and E:-(port Coefficient Tables
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ection 2;: PLOAD Data Requirements

Imperviousness Factor Tables

The "simple” calculation method requires that the user input a surface
imperviousness factor table.

The imperviousness factor table must consist of a minimum of two columns:

1. A Land Use ID column 2. An imperviousness factor column

— 1 | Fomest | T
7 |AGRICULTURE] T
5 | UReAN | 50

This is a sample imperviousness factor table. Codes used in the land use 1D
column must correspond to those used in the land use coverage .dbf file. The
numbers in the imperviousness factor column represent the percent
imperviousness (0-100) associated with each land use. Hence, higher
numbers in this column equate to a larger amount of water surface runoff for
the particular land use.

uirements +

BMP Tables
With both calculation methods, the user has the option of incorporating the
effects of Best Management Practices (BMPs). Doing so requires that the
user input a BMP table, as well as a BMP shapefile.
The BMP table must consist of a minimum of two columns:

1. A BMP ID column 2. A pollutant column

BMPType| BMP | TP | TN |
SOftbuffe] 70 | 30 |

This is a sample BMP table. It has two columns for pollutants. The pollutant
column titles must correspond with those used in the export coefficient or
EMC table. The numbers in the pollutant columns represent the BMP
efficiency rate (percent), soin this example the 50-ft buffer will remove 70
percent TP and 30 percent TN. Additional BMPs can be added as extra rows
in the table.

10
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Section 2: PLOAD Data Requirements «

Point Source Pollutant Tables

With both calculation methods, the user has the option of incorporating point
source pollutant loading. Doing so requires that the user input a point source
table, as well as a point source shapefile.

The point source table must consist of a minimum of two columns:

1. A point source |D column 2. A pollutant column

~

o] Bop | Tss |

This is a sample point source table. It has two columns for pollutants (BOD
and TSS), coming from one point source. Additional point sources can be
added as extra rows in the table.

Section 3: Identifying
Applicable Wetlands

11
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ection 3: Identifying Applicable Wetlands

PLOAD can be applied to any wetland with a defined catchment. The

wetland is the lowest elevation in the catchment. Therefore any rainfall
within the catchment will run off into the wetland.

Section 3: Identifying Applicable Wetlands

Drawing a Catchment:

Ifthe catchment for the wetland of interest is not already defined, users will
need to generate their own. Drawing the catchment will require some form
of elevation data. Accuracy of the catchment will depend on the precision of
the available elevation data.

Digital 2-ft contour lines work well in most areas, although higher resolution
could be needed in areas with very little relief (e.g. floodplains). However,
contour data at that detail may not be readily available for all areas.

Another altemative is to use USGS 1:24k topographic maps. These can be
obtained through this website: hitp:/iopomaps.usgs.qov

These maps generally contain 5-ft to 10-ft contour lines, and thus may not
be as accurate for drawing catchments in flatter regions of the country.

Also, if available, data from a field survey using standard surveying or GPS
equipment may be used to determine elevations.

12
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Section 4. Running PLOAD

Section 4: Running PLOAD

Shown below is the main PLOAD session screen. From this screen the user can create a
new session, input the wetland basins to be analyzed and the appropriate land use data set,
select the calculation method to be used, and choose whether or not to use BMPs or point
source pollutants in the analysis.

LOAD v3.0 - Pollutant Loading Parameters

1 - Create Session
Enter Yaur Session Name and Click ‘Create Session' (no spaces plea:

Create Session_| [

st b Enagement Fractices?.

Mo

P Calealatice.:

Please Mote: PLOAD assumes spatial units are in meters.

14
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Section 4: Running PLOAD

PLOAD assumes that the spatial units of the basin({s) and land use shapefile

inputs are in meters. If the original input files have different spatial units (feet, for

example), they will need to be re-projected into meters. For those unfamiliar with
mini-tutorial on re-projecting shapefiles can be accessed by clicking

Section 4: Running PLOAI >

The final option on the main PLOAD session screen is whether or not to use a pre-existing
intersectfidentity data set. In order to perform its analysis, PLOAD intersects the basin
boundaries input by the user with the land use file that has been input. This option allows
users to input an intersected data set that they have generated on their own, rather than
letting PLOAD run the intersection.

8 - Uze Presxisting Intersect of Intersect/Identity Data Set?

Pre-Frocessed Data Set Ic‘\pbad example files\dp_il_subwatershe

ALWAYS SELECT ‘YES’ AT THIS SECTION. Due to a potential program ‘bug’
PLOAD will not generate loading output for small basins if the user selects “No” and
lets the program intersect the data. It is unclear exactly how small the basins need to
be before this bug manifests itself, but most catchments for individual wetlands are
probably small enough for this problem to occur. Therefore, users should always pre-
intersect the land use and basin shapefiles in ArcView, and use that intersected file as
the input in this step. For those unfamiliar with ArcView, a mini-tutorial on intersecting
shapefiles can be accessed by clicking here.

15
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Section 5: Choosing a
Calculation Method

n Met

PLOAD will calculate pollutant loads based on one of two user-selected
methods: the “simple” calculation method or the “export coefficient”
calculation method.

Selecting a method will largely depend on the land use composition
and size of the wetland basin(s) being studied, as well as data
availability for the area.

The next two slides summarize the utility of each of these methods.
The actual mathematical formulas used in these methods are detailed
in the PLOAD user's manual.

16
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Section 5: Choosing a Calculation Method <

The “Simple” Calculation Method
= This method is applicable only for drainage areas of less than 1 square mile.

« The "simple” method requires event mean concentration (EMC) data. Because
EMC data are generally available for urban land use types, this method is best
suited for wetlands located in urban environments.

Chogse a Calculation Method
& “Simple" Calculation Method
Precipitation P
Arnual Precipiation inInchesP) [382

Ratio of Storms Producing RunofffPjl [0.9

Bacteria Option for 'Simple Methad
€ *es, Specily a Palltant as Bacteria
& No. Do Mot Specify 4 Pollutant a= Bacteria

Load EMC Tabl

EMC Table |c:\glcad example fileshemctable xls
Landuse Field [LU_Eude

Polutark Fieid [TF

Load Impervious Table

Impervious Tabls [ e:\pload example fileshemetable sls
Landuse Field [T cade

Imperiious Rating Field [TMPERY

PLOAD “simple” calculation input screen

By,
L
Section 5: Choosing a Calculation Method

The “Export Coefficient” Calculation Method

In most situations, the “export coefficient” method will be the
preferred way to calculate pollutant loads into the wetland. Using
this method requires export coefficients. This method works for
areas containing mixed land use, and the drainage area can be of
any size. This method also requires fewer data inputs than the
“simple” calculation method.

= " Export Coefficient'" Calculation Method

(Load Expoit Coefficient Table — 1
Export Coefficient Table Ic.\plaad example fileshexportcoefficient_table.xk
=

Landuse Field ]LU_Eode

Polltant Fielc [TF |

PLOAD “Export Coefficient” calculation input screen

17
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Section 6: Incorporating BMPs

Section 6: Incorporating BMPs

—

+50 ft buffer BMP

18
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on 6: Incorporating BMPs

Incorporating BMPs into PLOAD requires two files: a BMP shapefile and a BMP table.

Although the BMP shapefile can be either a point or polygon coverage, the author has encountered
problems in using point coverages and therefore recommends polygon coverages.

The BMP shapefile input is the area served by the BMP. In the example in the previous slide, the 50-ft
buffer BMP is reducing runoff to the wetland from the entire catchment. In order to simulate this effect,
the inputted BMP shapefile is the same size and shape as the catchment itself. The BMP type names in
the associated .dbf file must be identical to those used in the BMP table.

Attributes of Bmp_example.shp

2d .dbffile.

Section 7: Incorporating Land
Use Changes

19
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Section 7: Incorporating Land Use Changes

PLOAD can also address the effect of changes in land use on pollutant
loading into the wetland.

In order to perform this analysis, the user must first incorporate the
changes into the land use shapefile input to PLOAD. This can be done
by using the polygon edit feature in ArcView®. For those unfamiliar with
running ArcView, a mini tutorial can be accessed by clicking here.

To analyze changes in pollutant loading due to altered land use,
PLOAD must be run twice; once with the original land use input file,
and then again with the new landuse file. The outputs from the two
iterations can then be compared to evaluate changes in pollutant
loading.

The next slide is an example of using PLOAD to measure changes in
TP loading due to urban development in an agricultural area.

Section 7: Incorporating Land Use Changes >

20
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Section 8: Sources for
Obtaining Data

Section 8. Sources for Obtaining Data

EMC and Export Coefficient Data:
The back of the PLOAD user's manual provides EMC and export coefficient data
and references for several areas of the country, although this is far from being a
comprehensive list.
Atechnical note by Lin (ERDC/TN WRAP-04-3) provides additional sources for
EMC and export coefficient values, as well as guidance on how to select
appropriate numbers.

Land Use Files

Many states maintain their own web-based GIS data clearinghouses. These
websites are usually a good source for obtaining local and regional land use
coverages. The following website:

http:Aibraries.mit.edu/gis/data/statecenter.himl contains links to many of these
state GIS websites.

21
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Changing the PLOAD Land Use Input File using _
ArcView® 3.x

Changing the PLOAD Land Use Input File using _
ArcView® 3.x

Step 1: First, open the "example_olc shp” fi hen, underthe "Theme" menu at the
Start Editing."

22
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Changing the PLOAD Land Use Input File using _
ArcView® 3.x e

Changing the PLOAD Land Use Input File using -
ArcView® 3.x tack s an

) the border of the area that will have a
he line.
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Changing the PLOAD Land Use Input File using _
ArcView® 3.x

Step 4: Click on the "select feature” command

Changing the PLOAD Land Use Input File using h
Arc\!mwmu 3 X

24
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Changing the PLOAD Landuse Input File using 4mm
ArcView® 3.x

Step 6 Under the 'Edit’ menu at the top of the screen, select "Union Features .’

Changing the PLOAD Land Use Input File using 4
ArcView® 3.x

Step 7: Select the "Open Theme Table" icon.

25
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Changing the PLOAD Land Us Input File using _
ArcView
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Changing the PLOAD Land Use Input File using 4l
ArcView® 3.x s

Step 10: Close the theme table. On the map screen, select “Save Edits As” from the
“Theme” menu at the top of the screen. Save this shapefile under a new name. This
new shapefile can now be used as the “altered land use” input in PLOAD.

Intersecting Shapefiles Using ArcView® 3.x

Step 1: Underthe View' menu at the top ofthe screen, select ‘Add Theme.' When the
‘Add Theme' menu appears, select the land use (dp_watershed_lu.shp)) and basins
(example_catchment.shp) shapefiles, then click ‘OK’ to add them to the view.

AddEvert The
New Theme...
s Oif

I
Directory: | c\pload example files oK |

TOC Style.

B bufflshp A [E e
E dp_il_subwateisheds shp B pload example fles
bratersheds_inter:

§ & Directories
example_catchment_inters:  Libraies
B examole new usho =

FEhhes Data Source Types: Drives;

| Feature Data Source =] e
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Intersecting Shapefiles Using ArcView® 3.x 7

Step 2: Under the ‘File’ menu at the top of the screen, select ‘Extensions.’ When the
Extensions window opens, click on the ‘Geoprocessing’ extension.

|42 Extensions

Avalable Extensions:
_| CiB Image Support ;I 0K
Datsbase Access J Cancel

Dislog Designer
Digitizer

(Geoprocessing Reset
Graficules and Measured Grids I Maks Detault
Giid Projector ﬂ

Intersecting Shapefiles Using Ar

Step 3: Under the ‘View' menu at the top of the screen, select ‘GeoProcessing Wizard.'
When the ‘Geoprocessing’ window opens, select ‘Intersect two themes,’ then press the

‘Next’ button.

0 GeuProcessing

oo a echizcmag apeisean IMamact

10, CAch W N Eniics I Choces WG OPATINON CUTE AN MUt
opmone th the Seatures fiom
" Dimsolon bsatares Lupsd o o asbse
1 Hergs Memes ogetrer

Gl one theme based on arother

7 Irbessect s thesves

£ Usion v herses

© Auign dita by caton

Bosiatiord gt Owrlay  Output

e |
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Intersecting Shapefiles Using ArcView® 3.x

Step 4: Under “Select input theme to intersect,” select the landuse file. Under ‘Select an
overlay theme, select the basin(s) file. Choose a name for the new file, and click the

‘Finish’ button. This new file can now be used as the pre-intersected file when running
PLOAD.

2 GeoProcessing

1) Select input thame lo intersect: About Intersect

This operation culs an input

theme with the features from

an overlay theme to produce
Numbet of Features: an output theme with features

2] Select an overlay theme: that have attribute data from

[ Example_catchment shp both themes.

Number of Festures: 1 f’é’ i @ = @
3) Specify the output file Input Owerlay  Output
Qutput File: [ ¢:\docume™T\udeswiplocal

More about Intersect

Help... | Cancel | ccBack Finish

Changing Projections in ArcView® 3.x

Changing the projection of shapefiles in ArcView 3.x requires that the original projection of
the shapefile is known. Because ArcView shapefiles do not store projection information, the
original projection information needs to be obtained from previously documented sources,
such as an associated metadata file. Most shapefiles downloaded from government GIS
clearinghouses will have this metadata available.

In the following example, we will change a shapefile from IL East 1983 State Plane (feet)
projection to UTM 1983 (meters) projection.

Step 1: Under the ‘File’ menu at the top of the screen, select ‘Extensions.’ VWhen the
Extensions window opens, click on the ‘Projector!’ extension.

ArcView GIS 3.2a

B Edt Yiew Iheme Graphics Window Help
Llose

Cloge Al = Avalable Extensions:

Sek orking Diveclory. JPEG (IFIF} Image Suppat |
Save Project s — _| Legend Todl

Save Projsct As... _| ModelBuilder

! Extensions

Cancel

MiSID Image Suppart

MITF Image Support J Reset I

¥ Profectul I Make Defaut
Expout | Projection Utility ‘Wizard =l

Manage Data Sources. .
Exit
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Changing Projections in ArcView® 3.x

Step 2: Under the View’ menu at the top of the screen, select ‘Properties.” When the
‘iew Properties’ screen appears, for ‘Map Units,” select the map units of the current
projection. In this example, the current map units are in feet. Press ‘OK when done.

Arc¥iew GIS 3.2a
fie Ect I Ineme Grephics Window Help

Hdd Theme. Chil+T

w Properties

Hame: [ View!

Geocode Ad 5 e =
Aedd Evvert T Creation Date: | Maonday, Februam 09, 2004 09:15:49 AM

Hew Theme. Creator: |
Themes On
Themes Off

Cancel

bap Ui

Layaut. Distance Units: | unkrnown

TOC Style...

Full Extent

=l

Projection Area OF Interest I
Zaam |n

Zoom Qut

Z ToTh Background Calar; E Select Color... I
oom To Themes

Zoom To Selected Comments.

Zoom Prexious

Eind...

Loeate Address..

Chil+F

Changing Projections in ArcView® 3.x

Step 3: At the top of the screen, click on the ‘Projector!’ icon.

& ArcView GIS 3.2a
Eile  Edit ¥iew Theme [Graphics Mindow Help

]
Changelgrfiection

Step 4: When the first 'Projection Properties’ menu appears, select the current
projection of the shapefile. In this case, it is 1983 State Plane, lllinois East.
Press OK.

#! Projection Properties

1 Standard " Custom

Projection: Transverse Mercator
Spheroid: GRS 80

Central Meridian: -83.3333333334
Reference Latitude: 26 BEEEEEEEET
Scale Factor: 0.939375

False Easting: 934243.9938939359
Falze Morthing: O
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Changing Projections in ArcView® 3.x

Step 5: The next menu will ask you to select the map units of the new projection. For the purposes
of PLOAD, always select meters.

£ Projector!

Flease pick output units

[ meters

Step 6: In the next menu, select the new projection. In this case, it is UTM-1983 Zone 16. Press
‘OK to reproject the file. If you are unsure what UTM zone your region is in, you can check it at this

site: hitp:/Awww.dmap.co.ukfutmworld.htm

ojection Properties

= Standard " Custom

Category: [UTM - 1983
Tooe: T

Projectionc Transverse Mercator
Spheroid: GRS 80

Central Meridian: -87

Reference Latitude: 0

Scale Factor 0.9338
False E asting: 500000

False Narthing: 0
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